

































































































































































































































































































































































































































































































































































































































































































































































General Preferences

Chapter 18

General Preferences

1 Choose the Photoshop Color Picker to
access the application’s own Color Picker.
If you’re trying to mix a color in
Photashop to match a color in
Macromedia Director or Netscape
Navigator, use the Apple Color Picker.

2 Choose an Interpolation option for rein-
terpretation of an image as a result of
resampling or transforming. Bicubic is
slowest, but the highest quality. Nearest
Neighbor is the fastest, but the poorest
quality.

3 Check Anti-alias PostScript to optimize
the rendering of EPS images in Photoshop.

4 Check Export Clipboard to have the cur-
rent Clipboard contents stay on the
Clipboard when you quit Photoshop.

5 Check Short PANTONE Names if your
image contains Pantone colors and yeu
are exporting it to another application.,

; Vi I A tool tip.
Airbrush Tool (4) |
| w1 T

& Check Show Tool Tips to see an on-
screen display of the name of the tool
or icon currently under the cursor.

7 Check Beep When Done for a beep to
sound after any command, for which a
progress bar displays, is completed.

8 With Dynamic Color Sliders checked,
the Color palette sliders update as you
move them. Turn this option off to
speed performance.

9 With Save Palette Locations checked,
palettes that are open when you quit
Photoshop will appear in their same
location when you re-launch.

10 To restore the palettes’ default group-
ings when you launch Photoshop, click
Reset Palette Locations to Default.

Preferences —

[ General |v]

1 Color Picker: Phutuslm[E

Cancel

2 Interpolation: [ Bicubic (Batter)

1=

Options
| 2
é (%] Enport Clipboard

& [X] Show Tool Tips

3 [x] Anti-alias PostScript [ Beep When Done 7
[ bynamic Coler Sliders 8
5 [¥] Short PANTONE Names [X] Save Palette Locations @

[ Reset Palette Locations to Default | 10
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Alpha channel

A special 8-bit grayscale channel that is
used for saving a selection.

Anti-alias

The blending of pixel colors on the perime-
ter of hard-edged shapes, like type, to
smoooth undesirable stair-stepping (jaggies).

Ascll

(American Standard Code for Information
Interchange) A standard editable format
for encoding data.

Background color

The color applied when the Eraser tool is
used, the canvas size is enlarged, or a selec-
tion is moved on the Background of an
image.

Bézier curve

A curved line segment drawn using the Pen
tool. It consists of anchor points with
direction lines with which the curve can be
reshaped.

Binary

In Photoshop, a method for encoding data.
Binary encoding is more compact than
ASCII encoding.

(Binary digit) The smallest unit of informa-
tion on a computer. Eight bits equal one
byte. (see Byte)

Bit depth

The number of bits used to store a pixel’s
color information on a computer monitor.

{IPPENDIX 2. GLOSSARY

Bitmap

The display of an image on a computer
screen via the geometric mapping of a sin-
gle layer of pixels on a rectangular grid. In
Photoshop, Bitmap is also a one-channel
mode consisting of black and white pixels.

Blend (see Gradient)
Brightness (scc Lightness)

Burn
To darken an area of an image.

Byte

The basic unit of storage memory. One
byte equals eight bits. One kilobyte (K, Kb)
equals 1,024 bytes. One megabyte (M, MB)
equals 1,024 kilobytes. One gigabyte

(G, Gb) equals 1,024 megabytes.

Kipsso)g

Canvas size

The size of an image, including a border, if
any, around it.

Channel

An image component that contains the
pixel information for an individual color.
A grayscale image contains one channel, an
RGB image contains three channels, and a
CMYK image contains four channels.

Clipboard

An area of memory used to temporarily
store selection pixels. The Clipboard is
accessed via the Cut, Copy, and Paste com-
mands.

Clipping
In Photoshop, the automatic adjustment of
colors to bring them into printable gamut.
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To copy image areas using the Rubber
Stamp tool.

CMYK

(Cyan, Magenta, Yellow, and Black) The
four ink colors used in process printing.
Cyan, magenta, and yellow are the three
subtractive primaries. When combined in
their purest form, they theoretically pro-
duce black, but in actuality, they produce a
dark muddy color. CMYK colors are simu-
lated on a computer monitor using addi-
tive, red, green, and blue light. To color
separate an image from Photoshop, con-
vert it to CMYK Color mode.

Color correction

The adjustment of color in an image to
match original artwork or a photograph.
Color correction is usually done in CMYK
Color mode in preparation for process
printing.

Color separation

The production of a separate sheet of film
for each ink color that will be used to print
an image. Four plates are used in process
color separation, one each for Cyan,
Magenta, Yellow, and Black.

Color table

The color palette of up to 256 colors of an
image in Indexed Color mode.

Continvous-tone image

An image, like a photograph, in which
there are smooth gradations between
shades or colors.

Confrast

The degree of difference between lights
and darks in an image. A high contrast
image is comprised of only very light and
very dark pixels.

Crop

To trim away part of an image.

Crop marks

Short, fine lines placed around the edges of
a page to designate where the paper is to
be trimmed art a print shop.

DCs

(Desktop Color Separation) A file format
in which a color image is broken down
into five PostScript files: Cyan, Magenta,
Yellow and Black for high resolution print-
ing, and an optional low resolution file for
previewing and laser printing.

To translate flat art or a transparency into
computer-readable numbers using a scan-
ning device and scanning software.

Dimensions
The width and height of an image.

The mixing of adjacent pixels to simulate
additional colors when available colors are
limited, such as on an 8-bit monitor.

Dodge
To bleach (lighten) an area of an image.
Also, a so-so car model.

Dot gain
The undesirable spreading and enlarging of
ink dots on paper.

Dpi

(Dots Per Inch) A unit used to measure the
resolution of a printer. Dpi is sometimes
used to describe the input resolution of a
scanner, but “ppi™ is the more accurate
term.

Duotone
A prayscale image printed using two plates
for added tonal depth. A tritone is printed
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using three plates. A quadtone is printed
using four plates.

Dye sublimation

A continuous-tone printing process

in which a solid printing medium is con-
verted into a gas before it hits the paper.

8-hit monitor

A monitor in which each pixel stores eight
bits of information and represents one of
only 256 available colors. Dithering is used
to simulate additional colors.

EPS

(Encapsulated PostScript) An image file
format containing PostScript code and, in
the case of Photoshop, an optional PICT
image for screen display. EPS is a common-
ly used format for moving files from one
application to another and for imageset-
ting and color separating.

Equalize
To balance an image’s lights and darks.

Feather

To fade the edge of a selection or mask a
specified number of pixels (the feather
radius).

Fill
To fill a selection wich a shade, color, pat-
tern, or blend.

Film negative
A film rendition of an image in which dark
and light areas are reversed.

Floating selection

An area of an image that is surrounded by
a marquee and can be moved or modified
without affecting underlying pixels.

Foni
A typeface in a distinctive style, such as
Futura Bold Italic.

Foreground color

The color applied when a painting tool is
used or type is created.

Gradient fill

In Photoshop, a graduated blend between
colors that is produced by the Gradient
tool.

Grayscale

An image containing black, white, and up
to 256 shades of gray, but no color. In
Photoshop, Grayscale is a one-channel
image mode.

Halftone screen

A pattern of tiny dots that is used for
printing an image to simulate smooth
tones.

Highlights

The lightest areas of an image.

Histogram

A graph showing the distribution of an
image’s color and/or luminosity values.

HSB
See Hue, Saturation, and Brightness.

Hue

The wavelength of light of a pure color
that gives a color its name—such as red or
blue—independent of its saturation or
brightness.

Imagesetier

A high-resolution printer (usually 1,270 or
2,540 dpi) that generates paper or film
output from a computer file.

Iindexed color

In Photoshop, an image mode in which
there is only one channel and a color table
containing up to 256 colors. All the colors
of an Indexed Color image are displayed
on its Colors palette.
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Interpolation

The recoloring of pixels as a result of
changing an image’s dimensions or resolu-
tion. Interpolation may cause an image to
look blurry when printed. You can choose
an interpolation method (Bicubic or
Nearest Neighbor) in Photoshop.

Inverse

To switch the selected and non-selected
areas of an image.

Invert

To reverse an image’s light and dark values
and/or colors.

JPEG compression

(Joint Photographic Experts Group) A
compression feature in Photoshop that is
used to reduce a file’s storage size. JPEG
can cause some image degradation.

Kern

To adjust the horizontal spacing between a
pair of characters.

Lab

A mode in which colors are related to the
CIE color reference system. In Photoshop,
an image in Lab Color mode is composed
of three channels, one for lightness, one
for green-to-red colors, and one blue-to-
vellow colors.

Leading

The space between lines of type, measured
from baseline to baseline. In Photoshop,
leading can be measured in points or pix-
els.

{Brightness) The lightness of a color inde-
pendent of its hue and saturation.

LPI

(Lines Per Inch, halfrone frequency, screen
frequency) The unit used to measure the

frequency of rows of dots on a halftone
screen.

Luminesity

The distribution of an image’s light and
dark values.

Marguee
The moving border that defines a selection.

Maslk

An “electronic” paint that protects an area
of an image from modification.

Midtones

The shades in an image that are midway
between the highlights and shadows.

A method for specifying how color infor-
mation is to be interpreted. An image can
be converted to a different image mode
(RGB to Indexed Color, for example); a
blending mode can be chosen for a paint-
ing or editing tool.

Moiré

An undesirable pattern that is caused by
improper halftone screen angles during
printing or when the pattern in an image
conflicts with proper halftone patterns.

Object-oriented

(also known as vector) A software method
used for describing and processing com-
puter files. Object-oriented graphics and
PostScript type are defined by mathematics
and geometry. Bitmapped graphics are
defined by pixels on a rectangular grid.
Photoshop images are bitmapped.

Opacity

The density of a color or shade, ranging
from transparent to opaque. In Photoshop,
you can choose an opacity for a painting
or editing tool or a layer.
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Path

A shape that is comprised of straight and/or
curved segments joined by anchor points.

PICT

A Macintosh file formart that is used to
display and save images. Save a Photoshop
image as a PICT to open it in a video or
animation program, The PICT format is
not use for color separations.

Pixels

(Image elements) The individual dots that
are used to display an image on a computer
monitor.

PPI

(Pixels per inch) The unit used to measure
the resolution of a scan or of a Photoshop
image.

Plug-in module

Third-party software that is loaded into the
Photoshop Plug-ins folder so it can be
accessed from a Photoshop menu. Or, a
plug-in module that comes with Photoshop
that is used to facilitate Import, Export, or
file format conversion operations.

A unit of measure used to describe type size
(measured from ascender to descender),
leading (measured from baseline to base-
line), and line width.

Polygon

A closed shape composed of three or more
straight sides.

Produce a special effect in an image by
reducing the number of shades of gray or
colors to a specified—usually low—number.

PosiScript
The page description language created and
licensed by Adobe Systems Incorporated

that is used for displaying and printing
fonts and images.

Process color

Ink that is printed from four separate
plates, one each for Cyan (C), Magenta
(M), Yellow (Y), and Black (K), and which
in combination produce a wide range of
colors.

Quick Mask

In Photoshop, a screen display mode in
which a translucent colored mask covers
selected or unselected areas of an image.
Painting tools can be used to reshape a
Quick Mask.

{Random Access Memory) The system
memory of a computer that is used for run-
ning an application, processing informa-
tion, and temporary storage.

Rasterize

The conversion of an object-oriented image
into a bitmapped image. When an Adobe
Hlustrator graphic is placed into
Photoshop, for example, it is rasterized. All
computer files are rasterized when they’re
printed.

Registration marks

Crosshair marks placed around the edges
of a page that are used to align printing
plates.

Resample

Change an image’s resolution while keep-
ing its pixels dimensions constant.

Resolution

The fineness of detail of a digital image
(measured in pixels per inch), a monitor
(measured in pixels per inch—usually 72
ppi), a printer (measured in dots per inch),
or a halftone screen (measured in lines per
inch).
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RGB

Color used to produce transmitted light.
When pure Red, Green, and Blue light (the
additive primaries) are combined, as on a
computer monitor, white is produced. In
Photoshop, RGB Color is a three-channel
image mode.

Saturation

The purity of a color. The more gray a
color contains, the lower its saturation.

Sean

To digitize a slide, photograph or other
artwork using a scanner and scanning soft-
ware so it can be displayed, edited, and
possibly output from, a computer.

Scrafch disk

(also known as virtual memory) Hard
drive storage space that is designated as
work space for processing operations
and for temporarily storing part of an
image and a backup version of the image
when there is insufficient RAM for those
functions.

Screen angles

Angles used for positioning halftone
screens when producing film to minimize
undesirable dot patterns (moirés).

Screen frequency

(screen ruling) The resolution (density of
dots) on a halftone screen, measured in
lines per inch.

Selection

An area of an image that is isolated so it
can be modified while the rest of the image
is protected. A moving marquee, which
denotes the boundary of a selection, can be
moved independently of its contents.

Shadows
The darkest areas of an image.

A mixed ink color used in printing. A sepa-
rate plate is used to print each spot color.
Pantone is a commonly used spot color
matching system. (see Process color)
Photoshop doesn’t generate spot color
plates.

Thermal wax

A color printing process in which a
sequence of three to four ink sheets are
used to place colored dots on special paper.

TIFF

(Tagged Image File Format) A common file
format that is used for saving bitmapped
images, such as scans. TIFF images can be
color separated.

Tolerance

The range of pixels within which a tool
operates, like the range of shades or colors
the Magic Wand tool selects or the Paint
Bucket tool fills.

Trap

The overlapping of adjacent colors to pre-
vent undesirable gaps from occuring as a
result of the misalignment of printing
plates or paper.

24-hit monitor

A monitor with a video card in which each
pixel can store up to 24 bits of informa-
tion. The video card contains three color
tables for displaying an RGB image, one
each for Red, Green, and Blue, and each
containing 256 colors. Together they can
produce 16.7 million colors. On a 24-bit
monitor, smooth blends can be displayed,
so dithering isn’t necessary.
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Ten questions and answers about copyright
Written by Tad Crawford

Why is copyright important?

If you are a creator of images (whether Photoshop user, photographer,
designer, or fine artist), copyright protects you from having your
images stolen by someone else. As the copyright owner, you may
either allow or prevent anyone else from making copies of your work,
making derivations from your work (such as a poster made from a
photograph), or displaying your work publicly. Your copyrights last
for your lifetime plus another fifty years, so a successful work may
benefit not only you but your heirs as well. If you are a user of
images, it is important that you understand the rights and obligations
connected with their use so you don’t infringe on the copyright of
someone else and expose yourself to legal or financial liabilities.

What is an infringement?

Infringement is unauthorized use of someone else’s work. The test for
infringement is whether an ordinary observer would believe one work
was copied from another.

Is it an infringement if | scan an old image into Photoshop and
change i#?

If the image was created in the United States and is more than 75
years old, it is in the public domain and can be freely copied by you
or anyone else. You will have copyright in the new elements of the
image that you create.

uoidejold YBiihde)

Is it an infringement if | scan a recent photograph inte
Photoshop and change it?

The scanning itself is making a copy and so is an infringement. As a
practical matter, however, it is unlikely you will be sued for infringe-
ment if you change the photograph to the point where an ordinary
observer would no longer believe your work was copied from the
original photograph.

What does “fair use” mean in terms of copyright?

A fair use is a use of someone else’s work that is allowed under the
copyright law. For example, newsworthy or educational uses are like-
ly to be fair uses. The factors for whether a use is a fair use or an
infringement are: (1) the purpose and character of the use, including
whether or not it is for profit (2) the character of the copyrighted
work (3) how much of the total work is used and (4) what effect the
use will have on the market for or value of the work being copied.
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Can | use arecognizable part of a photograph if the entire
source photograph is not recognizable?

You would have to apply the fair use factors. Obviously, factor
(3) in the previous answer relating to how much of the total
work is used would be in your favor, but if the use is to make a
profit and will damage the market for the source photograph it
might be considered an infringement.

What are the damages for infringement?

The damages are the actual losses of the person infringed plus
any profits of the infringer. In some cases (especially if the work
was registered before the infringement), the court can simply
award between $500 and $20,000 for each work infringed. If the
infringement is willful, the court can award as much as
$100,000.

Do | have o register my images o obtain my copyright?
No, you have the copyright from the moment you create a work.
However, registration with the Copyright Office costs $20 and
will help you in the event your work is infringed. To obtain
Copyright Application Form VA (for Visual Arts), write to the
Copyright Office, Library of Congress, Washington, D.C. 20559
or call (202) 707-9100. Ask for the free Copyright Information
Kit for the visual arts and you will receive many helpful circulars
developed by the Copyright Office.

Do | need to use copyright notice to obtain or profect my
copyright?

It is always wise to place copyright notice on your work, because
it is a visible symbol of your rights as copyright owner. Prior to
1989 the absence of copyright notice when the images were pub-
lished or publicly distributed could, in certain circumstances,
cause the loss of the copyright. Since March 1, 1989, the absence
of copyright notice cannot cause the loss of the copyright but
may give infringers a loophole to try and lessen their damages.
Copyright notice has three elements: (1) “Copyright” or “Copr”
or “©” (2) your name and (3) the year of first publication.

How do | get permission to reproduce an image?

A simple permission form will suffice, It should set forth what
kind of project you are doing, what materials you want to use,
what rights you need in the material, what credit line and copy-
right notice will be given, and what payment, if any, will be
made. The person giving permission should sign the permission
form. If you are using an image of a person for purposes of
advertising or trade, you should have them sign a model release.
If the person’s image is to be altered or placed in a sitnation that
didn’t occur, you would want the release to cover this. Otherwise
you may face a libel or invasion of privacy lawsuit.
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= —  [mbed Wolermark =

Capyright Info

Crealor ID: PictureMarc Demo | Personalize...

Concel
Type of Use: @ Restricted [:]
) Royaity Free
[ Adult Content
Watermark Durability: [Z]
less visible mare visible
e )\
less durable more durable
=~ Personolize Creator 1D = =
Click the Register button to obtain ‘
your own Creator 10 pia the Internet,
or contact Digimarc Corporation at:

URL: ‘hllp:/-'www.dlglmnrc.cnm/regis1er

Phone: U.S, +1-800-664-8277
Intl. #1-503-223-0127

Digital watermarking

The Embed Digimarc filter embeds nearly
invisible copyright information and a con-
tact address into a Photoshop image. The
watermark can’t easily be removed by
reworking the image in Photoshop, it will
be present in any copy or any printout of
the image, and it will even be retained if the
printed piece is redigitized by scanning, so
your image will always retain its original
copyright.

NOTE: To access the Digimarc filter, you
must use a 68040-based Mac or a Power
Mac. To install the Detect Watermark filter,
copy it from the Application CD-ROM
{(from Other Goodies > Optional Plugins >
Digimarc) to the Photoshop Plug-ins folder.

To create a valid copyright, you must
register with and pay a fee to Digimarc
Corporation. They will enter your personal
information into their database and issue
you a unique creator ID, so your water-
mark will contain your personal contact
and copyright information.

To embed a watermark:

1. Open a flattened version of the image
to be watermarked.

2. Choose Filter > Digimarc > Embed
Watermark.

3. If you don’t yet have a personal
Creator ID, click Personalize Hll, then
click Register to connect to the
Digimarc Web site or phone Digimarc
at the number listed in the dialog box.

&. Enter your Creator 1D number B, then
click OK.

5. Choose Type of Use: Restricted
for limited use, or Royalty Free for
unlimited use.

6. Optional: Check the Adult Content box
(this option is not yet available).

7. Enter a Watermark Durability value, or
move the slider. Enter 1 or 2 to create a

{Continued on the next page)
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nearly invisible mark that work best
with high-end printing. Enter 3 or 4 for
a more visible mark that is more suit-
able for multimedia or online formats,
where you might need to convert the
image to various bit depths. Keep in
mind that a watermark with a low
Durability value might be ruined by
image editing.

Click OK.

The Digimarc filter must be available to
view a watermark symbol already embed-
ded in an image. The title bar of an image
that contains a watermark will display a
copyright symbol ©.

To

read information about a

watermark:

p

With the image containing the water-
mark open, choose Filter > Digimarc >
Read Watermark. A dialog box display-
ing Creator ID and other information
will open.

Optional: If you want to have informa-
tion faxed back to you, dial the phone
number listed in the Watermark
Information dialog box.

or

If you’re currently hooked up to the
Web via a browser, click Web Lookup
to open the browser, then navigate to
the Digimarc Web site, where you'll see
the creator information.

3. Click OK to close the Watermark

Information dialog box.
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Lifeline, ©1996 Annefte Weintraub
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Actions,
add command to, 222
append actions set, 224
change command order in, 221
delete action, or command from
action, 223
duplicate, 223
exclude/include commands from, 217
insert menu command into, 218
insert pause into (break point), 221
insert stop into, 216
load actions set, 224
palette, 215
play on a batch of images, 219-220
play on one image, 219
record, 216
rerecord one command in an action, 223
rerecord using different dialog box
settings, 222
replace 224
save actions set, 224
Add Noise filter, 189, 192, 206
Adjust commands, 99, 104-107, 109-110,
122-128, 130
Adjustment layers,
create, 107
edit, 109
introduced 99
merge with underlying layer, 109
multiple, 109
tips and tricks, 109
use as a mask, 110
Adobe Type Manager, 177
Airbrush tool, 135-136, 140
All (select) command, 57
Alpha channel, 22, 158-162,
convert into a path, 166
delete, 171
display, 159
duplicate 161
load, 159, 160
modify mask colorfopacity, 156, 164, 165

rename, 161

reshape, 162

reverse colors, 163-165

save selection to, 158, 160
Anti-aliased,

default, 267

selection, 57, 267

type, 177-188

when opening an image, 37-38
Anti-alias PostScript, 41
Apple Color Picker, 261
Arrow keys, 84
Arrows, draw, 137
Auto Levels, 104
Auto Resolution, 34

Background, convert into layer, 92
Background color,
choose, 111-1135
Color palette, 13
delete selection on Background, 64
move selection on Background, 69, 76, 83
Behind mode, 180, 149
Big Data, 74, 95, 97
Bitmap mode, 24
black and white points, 256, 257
Blending modes, 26-28
Blur filter, 210
Blur tool, 7§
Border selection, 63
Brightness/Contrast command, 103-104
Brushes palette, 15, 138-141
Brush set, save, load, 141
Brush tip,
create from an image, 140
create new, 139
delete, 139
modify, 138
Burn tool, 106, 107, 129

C
Calligraphic line, 139

-3
3
X
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Canvas Size, 46
Channels, 22-23
Channels, alpha, see Alpha channel
Channels palette, 14, 24, 157-163, 165, 169,
217
Clear command, 64
Clear Guides, 77
Clear mode, 26, 149
Clipboard, 69, 71, 73, 97
Clipping group of layers, 98, 154-155, 185
Clipping path, 175-176
Cloning, 78-80
Close an image, 52
CMYK Color general, 21-22
CMYK Preview, 254
Color,
adjust, 121-128
Background, 13, 84, 111-114, 197, 201
choose, 111-114
CMYK, 21-22, 112, 128, 240-246
custom, 113
default, 111
delete, 115
fill selection with, 117, 119
Foreground, 13, 111-11§
non—printable, 22, 112, 123, 125, 254
palette, 13-18, 111-116
Pantone, 113
process, 113
replace, 122-124
sample from an image (Eyedropper), 114
save, 118
separations, print, 242, 249-250
Color Balance command, 124, 259
Color Burn mode, 27
Color correction walk through, 255-260
Color Dodge mode, 27
Colorize a Grayscale image, 120, 124, 247
Color Mode, 28
Color Models, 13
Color palette, 13,
add color to, 115
append, 116
choose color from, 114
Color Bar, 114
delete a color from, 115
load swatch palette, 116
mix color on, 111
save, 115

Color Picker, 112, 226, 276
Color printer, 245-246
Color Range command, 62
Color Settings, 248-250
Color Table, Indexed, 263
Compress/Decompress EPS]PEG, 251,
269-270, 276-278
Compression, file, 251, 270
Context menus, 7, 20
Contrast, adjust, 99-110
Copy a layer, 155
Copy command, 71, 72, 73, 74
Copy Merged, 73
Copyright protection and questions, 301
Create new image, 36
Create new layer, 86
Crop,
an image, 47
a scan, 32
set dimension andfor resolution, 47
Crop marks, 238-239
Crop tool, 47
Cursors Preferences, 228
Curves command, 126-127, 258, 259
Custom Colors, 113
Cut command, 71, 72, 73

D
Darken mode, 28
Default Brushes, 141
Default colors icon, 111, 162
Default Swatches palette, 115, 116
Define Pattern command, 117, 180, 283
Defringe command, 84
Delete,
a layer, 97
a selection, 64, 70
Desaturate colors (Sponge tool), 130, 254
Desaturate command, 120
Deselect a selection, 64
Desktop Pattern, 253
Different mode, 28
Digital watermark, Digimarc, 303-304
Dimensions,
change for existing image, 42, 43, 46
of a new image, 36
of Clipboard contents, 71
Director, Macromedia,
Aliased vs. Anti-aliased, 267-268
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Copy/Paste into, 265-267
Filters, from Photoshop, 268
Paste as Bitmap, 265, 268
Paste as PICT, 2635, 266, 268
Reducing bit-depth of a cast member,
266-267
Transparency transitions, 267
Display & Cursors Preferences, 228
Display modes (screen), 55
Display size,
modify, 53-55
shortcuts, 54
Dissolve mode, 26
Distort, §9-90, 21
Dither,
Indexed Color conversion, 262
on Web image, 279
Document, see File
Document Sizes, 5, 35, 86
Dodge tool, 106, 107
Drag-and-drop a layer, 95, 96
Drag-and-drop a path, 168
Drag-and-drop a selection, 72
Drag-copy a selection, 70
Drop shadow, create, 142, 185
Duotone, 246-247
Duplicate a file, 50, 51
Duplicate a layer, 88
Duplicate command, 50
Dye sublimation printer, 237

Edit menu, 10
Elliptical selection, 58
Emboss filter, 191
EPS,

DCS file, 240

open as a new image, 40

place from Ilustrator, 41

save an image as, 244
Equalize command, 100
Eraser tool, 82, 144
Exclusion mode, 28
Export,

a path, 176

Clipboard, 71

GIF89a Export, 271, 273-275
Eyedropper tool, 114

F
Fade command, 99, 190
Fade-out distance, 136
Feather command,
selection, 59, 81
limit filter effect, 191
File, see Image
File compression, 251
File formats, 30, 240-245
File size units, 1
File storage size, 35, 270
Fill,
a path, 174
a selection, 117-118
patctern, 117-118, 283
shortcuts, 118
tools, 6
type, 180
using Paint Bucket, 143
Fill with Overlay-neutral color, 107, 129
Film recorder, output to, 241
Filter menu, 11
Filters, 189-214
apply to individual channel, 192
Artistic filters, 193-194,
Colored Pencil
Cutout
Dry Brush
Film Grain
Fresco
Neon Glow
Paint Daubs
Palette Knife
Plastic Wrap
Poster Edges
Rough Pastels
Smudge Stick
Sponge
Underpainting
Watercolor, 207
blending filter effects between layers,
Blur filters, 195,
Blur
Blur More
Gaussian Blur, 142, 184
Motion Blur, 210
Radial Blur
Smart Blur

156
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Brush Strokes filters, 196,
Accented Edges
Angled Strokes
Crosshatch
Dark Strokes
Ink Outlines
Spatter
Sprayed Strokes
Sumi-e

create texture using filters, 206-207
create watercolor using filters, 207

Distort filters, 197-198,
Diffuse Glow
Displace
Glass
Ocean Ripple
Pinch
Polar Coordinates
Ripple, 205, 207
Shear
Spherize
Twirl, 205, 207
Wave
Zigzag, 205

how to apply, 189-192

lessen effects of, 191-192

maximize effect of, 191

Noise filters, 198,

Add Noise, 206-207
Median

Other filters,
Minimum, 207

Pixelate filters, 199,
Color Halftone
Crystallize
Facet
Fragment
Mezzotint, 156
Mosaic, 208
Pointillize

Render filters, 200,
Clouds
Difference Clouds
Lens Flare

Sharpen filters, 200,
Sharpen Edges
Sharpen More
Unsharp Mask, 44-45

Sketch filters, 201-202,
Bas Relief
Chalk & Charcoal
Charcoal
Chrome
Conté Crayon
Graphic Pen
Halftone Pattern
Note Paper
Photocopy
Reticulation
Stamp
Torn Edges
Water Paper
Stylize filters, 203-204,
Diffuse
Emboss, 191
Extrude
Find Edges, 209
Glowing Edges
Solarize
Tiles
Trace Contour
Wind, 189
Texture filcers, 204, 207,
Craquelure
Grain
Patchwork
Stained Glass
Texturizer
using layer masks with filters, 191
Filters in Director, 268
Finger painting option for Smudge tool, 145
Flatten Image command, 98
Flip,
an image, 48
a layer, 88
a selection, 66
Floating selection, 9, 70, 87
turn into layer, 87
Font menu, update, 178
Foreground color,
choose, 111-115
painting tools, 111-114, 135, 162, 180
Frame selection, create, 63
Free Transform, 90-91
FreeHand, 176
Full Screen Mode/Full Screen Mode with
Menu Bar, 55
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G
Gamma, 253
Gamut (out of),
desaturate, 130, 254
indicator, 112
in Variations dialog box, 125
warning, 254
Gamut Warning, 254
Gaussian Blur filter, 142, 184, 195
General Preferences, 226
Glossary,
main, Appendix A,
mini, 8-9
Gradients, 131-134
create new, 132-133
edit existing, 133
Foreground/Background to transparent, 134
in a selection, 131
in type, 182
linear, 131
multicolor wash, 134
opacity, 134
radial, 131
savefload, 133
Grayscale image,
apply tints to, 146
colorize, 120
mode, 24
Grid, 76-77
Grow command, 60
Guides, 76-77
Guides & Grid Preferences, 231

Halftone screen frequency, 31-32, 34, 236
Hand tool, 55
Hard Light mode, 27
Hardware requirements, 1-2
Hide/Show Edges command, 66
Hide/Show layers, 88
Hide/Show Rulers, 76
High contrast, make an image, 101, 104
Highlights, adjust, 104, 106, 108, 126-128
Hue mode, 28
Hue/Saturation command,

colorize image using, 120

adjust color image, 121

remove color and recolor, 83

[lustrator, Adobe,
drag-and-drop into Illustrator, 241
drag-and-drop into Photoshop, 41
export clipping path to, 176, 241
export Photoshop image as EPS, 241-242
import type from, 41, 177
open, 40
paste, 40
place Hlustrator image into Photoshop, 41
place Photoshop image into Illustrator, 242
save Photoshop image to use as template
in, 242, 245
Image Cache, 225
Image modes, 23-25
Image (entire),
change canvas size, 46
change dimensions, 42, 43
change resolution, 43
close, 52
compression, 251
copy, 50, 51
create Background for, 36, 85, 92

create new, 36 5"
crop, 47 2.
duplicate, 50, §1 g
flip, 48

formats, 30, 49, 50
open, 37-40
rotate, 48
save as EPS, 244
save as TIFF, 245
save as PICT, 245
save new, 49
save new version of, 50, 51
size, 9, 35, 36,42, 86
size units, 1
thumbnail, 37
Image menu, 10
Imagesetter, 237
Image Size command, 42-43, 74
Indexed Color mode, 23, 261-264,
choose Spectrum table for, 264
convert to, 261-262
create Web palette from 272-273
edit color table of an image in, 263
recolor, 264
Info Bar, see Sizes Bar
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Info palette, 18, 58, 121, 250, 255, 256, 259
adjust neutral gray, 259
color info, 121
color correction, 255

Interpolation, 32, 42

Inverse command, 63, 65, 205

Invert command, 101, 105, 153, 159, 209

J
JPEG Compression, 251, 277-278

K

Keyboard shortcuts, listing (Appendix A),
285-294

Kodak Photo CD, 38-39

L
Lab Color mode, 25, 39, 236, 237
Laserwriter, 234, 235
Lasso tool, 59, 68,
Launch Photoshop, 29
Layer masks,
apply or discard, 153
create, 150
fill type with imagery using, 152
move, 152
reshape, 151
temporarily remove effects of, 153
Layer menu, 10
Layers, 85-98, 147-156
blend pixels berween, 26-28, 148, 149, 156
clipping group, 154-155, 183
convert Background into, 92
copy, 95-96, 97, 155
create, 86
delete, 97
distort, 89-91
drag-and-drop, 95, 96
duplicate, 155, 156
erase part of, 144
flatten, 98
flip, 88
free transform, 90-91
hide/show, 88
layer mask, 150-153
link, 96, 98, 152, 154
Merge Down, 98
Merge Group, 98
Merge Linked, 98

Merge Visible, 98
mode of, 93, 148, 149
move contents of, 94
neutral gray, 107, 129
new, 86
Numeric (transform), 91
opacity, 147
options, 148
palette, 16
perspective, 90, 91
preserve transparency of, 93
restack, 94
rotate, 89
scale, 89
screen back, 185
select entire, 57
skew, 89, 90
story boarding, 265-266
thumbnails, 86
transform, 89, 90, 91
turn a floating selection into, 87
Layer Via Copy, 87
Layer Via Cut, 87
Leading, 178
Levels command,
adjust neutral gray, 259
auto, 104
change luminosity of layer, 104
color correction, 128, 257-259

color correct individual channel, 128

screen back layer using, 185

set black and white points, 257-258

Lighten mode, 28
Lighting Effects filter, 211-214
Lights and darks, modify, 99-110
Linear gradient, 131-132
Lines,
calligraphic, 139
straight, 137
Line tool, 137
Link layers, 96, 98, 152, 154
Load,
actions set, 224
brush set, 141
channel selection, 159, 160
Color Range settings, 62
Separation Tables settings, 250
swatches, 116
Luminosity mode, 28
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LZW compression, 245, 251

Magic Wand tool,
anti-aliased selection, 267-268
selection, 60-61, 67
silhouette, 60
Tolerance, 60
Make Layer command (floating selection), 87
Marquee tool,
Rectangular, 58, 63
Elliptical, 58, 63
Masks, 150-153, 157-164
alpha channel, 157
layer, 150-153
link to layer image, 154
Quick Mask, 157, 163-164
Median filter, 207
Memory allocation, 2
Menu,
Edit, 10
File, 10
Filter, 11
Image, 10
Layer, 10
Select, 11
View, 11
Window, 11
Menu bar, 4-3
Merge Down, 98
Merge Group, 98
Merge Linked, 98
Merge Visible, 98
Mezzotint filter, 156
Midtones, adjust, 104, 105, 106, 108
Mini-glossary, 8-9
Mini color primer, 21-28
Minimum filter, 207
Modes,
Bitmap, 24
CMYK Color, 25
Duotone, 25
Grayscale, 24
Indexed Color, 25, 261-264, 266
Lab Color, 25, 236
Multichannel, 25, 261
RGB Color, 25
blending, 26-28
image, 23-23, 36

screen display, 55
Monitor setup, 248, 252
Mosaic filter, 208
Motion Blur filter, 210
Move,

contents of a layer, 94

an image in its window, 53, 55

a path, 168

a selection, 69

a selection marquee, 63

linked layers, 95, 96, 154

type, 179

Move tool, 69, 70, 72, 94
Multichannel mode, 25
Multimedia, 265-268

Navigator palette, 17, 53
Neutral transition layer, 107, 129
New image,
create, 36
save, 49
New Layer command, 86
New View, 56, 254
None (select), 64
Numeric {transform), 91

o
Opacity,
Fade command, 99, 190
fill, 117-118, 119
layer, 93, 147
line, 137
paint/edit tool, 26, 135
stroke, 118
Open an image, 37-40
Options palette, 15
Orientation, print, 239
Output, see Print or Web Output
Overlay mode, 27

P
Page preview, 4-5, 233
Page Setup dialog box, 239
Paintbrush tool, 135-136, 140
Paint Bucket tool, 143
Painting tools, 133-146
Palettes, 1218,

general info, 12
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Actions, 18
Brushes, 15
Channels, 14
Color, 13
Info, 18
Layers, 16
Navigator, 17
Options, 135
Paths, 17
Swatches, 14
thumbnails, 19
Pantone colors,
apply as tint on grayscale image, 247
choose, 113
Paste command, 71, 72, 74
Paste into a smaller image, 71, 74
Paste Into a selection, 73
Paths,
about, 165
clipping, 175
convert alpha channel into, 166
convert into a selection, 172
convert selection into, 166
copy, 168
create, 167
delete, 171
deselect, 172
display, 169
drag-and-drop, 168

export to lllustrator or FreeHand, 176

fill, 174

hide, 169

Make Selection, 172

move, 168

reshape, 170-171

rotate, 168

save, 168

scale, 168

select, 169

select points, 169

stroke, 173
Paths palette, 17, 165
Pattern,

define and use as a fill, 117, 283
Pencil tool, 137, 139
Pen tool,

create a path using, 167

reshape a path using, 170
Perspective, 89, 90, 91

Photo CD, 38-39
PhotoGrade, 235
Photoshop,
file format, 49, 86, 242
launch, 29
quit, 52
PICT,
save image as, 245
save an alpha channel with, 158
RGB vs. Indexed Color, 266
Pixel dimensions, 43

Pixels, 8, 21

Place an image from Adobe llustrator, 41

Plug-ins & Scratch Disk Preferences, 232
Polygon Lasso tool, 59
Polygonal selection, 59
Posterize, 102
PostScript Level 2, 25, 236-237
Preferences,
Display & Cursor, 228
General, 226
Guides & Grid, 231
Image Cache, 225
Plug-ins & Scratch Disk, 232
Saving Files, 37, 227
Transparency & Gamut, 229
Units & Rulers, 230
Preserve Transparency,
for layers, 93, 117, 119
for type, 179
with fills, 117, 119, 143
with filters, 192
with painting and editing, 136, 142
Printing Inks Setup, 249
Print/output topics,
calibration, 252-253
color correction, 255-260
color proof, 250
color separations, 23-235, 248-251
correct out of gamut colors, 254
devices, resolution of, 233
Director, 265-268
duotone, 246-247
dye sublimation, 237
file compression, 251
film recorder, 241
Halftone screens, 236
high-end color print, 237
HMlustrator, 241-242
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imagesetter, 237
IRIS, 237
laserwriter, 234-233
options, 234
Page Setup, 239
PageMaker, 240
Painter, 242-243
Pantone tint, 247
PhotoGrade, 235
PostScripe color, 236-237
potential gray levels, 35
preview box, 4-5, 42, 233
Print shop questions, 248
QuarkXPress, 240
questions for offset printing, 248
registration marks, 238-239
tips, 248
transparent background, 240, 243
trapping, 238
Web, 269-284
Process color, choose a, 112, 114
Production techniques, 19
Proof, color, 250
Purge, 2, 71

Q

QuarkXPress,
open a Quark EPS page, 37-38
print a Photoshop image from, 240
save an image to open in, 37-38

Quick Edit, 20

Quick Mask, 157, 163-164

Quit Photoshop, 52

R
RAM, 1-2, 35
Rectangular selection, 58, 63, 180
Registration marks, 238-239
Remove Black Matte/Remove White Matte, 84
Replace Color command, 122-123
Reposition, see Move
Resample Image, 42, 43
Reset,

dialog box, 99

palettes, 12, 226

tools, 15
Resize,

a palette or window, 4-5, 12

an image, 42-43

a selection, 67
Resolution, 31-32, 34, 43, 44, 47,71,
Auto, 34
calculate proper resolution for a scan or
an image, 34, 43
change, 43, 44, 47
modify, 43, 44
monitor, 34
of Clipboard contents, 71
of new document, 36, 38
on-screen output, 43
print output, 233, 234
printer, 233
scan, 31-32, 34
type, 177
Restack a layer, 94
Revert, 19, 49
RGB Color,
channels, 22-23
convert to CMYK, 23, 248-251
export as GIF, 273-275
general, 23-25
mode, 23-25
output, 23-25, 247
recolor via Indexed Color, 264
Ripple filter, 205, 207
Rotate,
a crop marquee, 47
an image, 48
a layer, 89-91
a path, 168
a selection, 66
Rotate canvas, 48
Rubber Stamp tool, 77, 78-80, 82
Rulers, 76, 77, 230
Ruler Origin, 76
Ruler units (choose), 4-3, 230

S

Sample Merged (layers), 93

for magic wand, 60
Saturation mode, 28
Save,

actions set, 224

brush set, 141

EPS, 244

existing image, 49

new image, 49

new version of an image, 50
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path, 168
PICT, 245
TIFF, 245
Save a Copy, 50, 51, 155
Save As (new version of a file), 50
Save Selection command, 158, 160
Saving Files Preferences, 37, 227
Scale,
a layer, 89-91
a selection, 66
Scan into Photoshop, 33
Scanning, 30-35
Scan sizes, 35
Scratch Disk Preferences, 232
Scratch Sizes, 3, 5
Screen back,
a layer, 105, 185
type, 181, 185
Screen display modes, 55
Select menu, 11
Select whole layer, 57
Selection,
add to, 67
anti-aliased, 59
border, 63
circular, §8
Color Range command, 62
Contract, 61, 66
convert into path, 166
convert path into, 172
copy, 71, 72
Defringe, 84
deselect, 64
delete, 64
drag-copy, 70
drag-and-drop, 72
elliptical, 58
entire layer, 57
Expand, 61, 66
feather, 81
fill, 117-118, 119
flip, 66
floating, 9, 70, 87
frame, 63
freeform, 59
Grow command, 60
hide marquee (Hide Edges), 66
Inverse, 65
Lasso tool, 59, 68

Load, 159, 160

Magic Wand tool, 60-61, 64, 65, 67

Marquee tool, 57-58, 63, 65, 68
move, 65, 69
move selection marquee, 65
paste, 73, 74
polygonal, 59
rectangular, 58
resize, 66
rotate, 66
save to a channel, 158, 160
Similar command, 60
smooth, 84
square, 58
stroke, 118
subtract from, 67
tools, 6, 58-61
transform, 66
type, 187-188
Selective Color command, 260
Separation Setup, 249
Separation Tables, 250
Shadows,
change colors in, 142, 185
drop, 142, 184
type, 184-185
Sharpen Edges filter, 200
Sharpen filter, 200
Sharpen tool, 75
Shortcuts, keyboard, list, 285
Short PANTONE Names, 226, 247
Show/Hide Edges command, 66
Show/Hide Grid, 76
Show/Hide Rulers, 76
Similar command, 60
Size,
file, 9, 23, 35,270
image, 9, 35, 36,42, 86
Sizes bar, 4-3, 335, 86, 233
Skew, 89-91
Smooth a selection, 8§4
Smudge, 145
Snap to Grid, 76
Snap to Guides, 76
Snapshot, 77
Soft Light mode, 27
Solarize filter, 203
Sponge tool, 130, 254
Standard Screen Mode, 55
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Stroke,

layer or selection, 118

path, 173
Stylus, 137
Swatches palette, 14, 115-116, 117
Switch colors icon, 111, 162, 163
System Palette, default, 228, 261

T
Take Snapshot, 77
Texture filters, 204, 207
Texture maps, 187, 188, 192
Textures, create using filters, 206-207
Texturize a pattern, 209
Threshold command, 101, 104
Thumbnails,

channel, 157

file, 37

image, 37

layer, 86

layer mask, 150

palette, 19

path, 165
TIFF,

CMYK, 245

save alpha channel in a, 158

save image as, 245
Tiles filter, 203
Tint a grayscale image, 120, 146
Title bar, 4-5
Tolerance, for Magic Wand tool, 60-61
Toolboex, 6-7
Tool tips, 7, 226
Trace Contour filter, 204
Transform,

free transform, 90-91

selection, 66

layer, 89-91
Transition layer, 107, 129
Transparency & Gamut Preferences, 229
Transparent background, 36, 85, 243
Trapping, 238
TrueType fonts, 177
Trumatch colors, 113, 116
TWAIN-Acquire, TWAIN-Select Source, 33
Twirl filter, 205, 207
Type, 177-188,

3D type, 187-188

alignment, 178

apply filter to, 182
clipping group, 152, 183
create, 178-179
delete, 178
deselect, 188
fading, 186
fill with a gradient, 182
fill with imagery, 152, 182
fill with a pattern, 182
fonts, 178
from Adobe Hlustrator, 41, 177, 241-242
layer mask, 148
leading, 178
move, 179
recolor, 180
resolution, 177
screen back, 181, 185
screen back an image with, 181
selection (Type Mask tool), 187-188
shadow, 184
size, 178
spacing, 178
style, 178
Type tool, 178
Type Mask tool, 152, 187-188
ways to modify, 182
Typeface, see Fonts

U

Undo command, 10, 77, 118, 123, 130, 131
Units & Rulers Preferences, 230

Unsharp Mask filter, 44-45, 200

Vv

Variations command,

for color image, 125

for grayscale image, 108
View menu, 11
Vignette an image, 68
Virtual Memory, 2, 3

w
Watercolor effect, 207
Web output, 34, 269-284,
alias, anti-alias, 267-268, 280
calculate image size for, 34, 269-270
color depth, 273
color palette, 271-272
Color Pickers, Photoshop, vs. Apple, 276

xopuj
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dithering, 279
file size issues, 269-270
GIF, 271-272
GIF89 Export, 273-274
HTML code, 269
image size in pixels, 34, 269-270
JPEG, 276-278
Modem speeds, 270
PNG file format, 278
patterned background, 281-283
Transparent GIF, 275
using Layers palette to lay out a Web
page, 284
Web browser, 269, 272
Web palette, 272
Wet Edges option, 135-136

Psst! Want to contact the authors?

Call Peachpit Press (1-800-283-9444), and
ask them for our current e-mail address.

By the way, what do you think of this book?
And...what should we write about next?

Wind filter, 192, 204

Window, create a new, 56, 254
Window menu, 11, 36
WidowShade option, 13

Work canvas, recolor, 56

World Wide Web, see Web output

y 4
Zigzag filter, 198, 205
Zoom,
box, 4-5
In/Zoom Out buttons, 53
percentage, 53
shortcuts, 54
tool, 54
using Navigator palette, 53, 55
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